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Introducing VidCap

VidCap is a data-capture application that lets you capture video sequences onto your 
computer system. With VidCap, you can capture individual images or entire video 
sequences from a VCR, a videodisc player, or a video camera and microphone. VidCap 
focuses on data collection; the VidEdit application, also included with Video for Windows, 
supports functions such as editing, compression, and formatting. 



See Also 
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Capturing Video

Capturing one or more frames of an audio-video sequence involves setting up audio and 
video sources, supplying capture settings to VidCap, and performing the actual capture 
session. You'll first need to perform the following tasks:
1 Connect the audio and video sources to the capture board and audio board. For more 

information, see the documentation for your capture board.
2 Configure frame display and video source options for VidCap. For more information, see 

the topics beginning with Configuring VidCap.
3 Set up the capture file, and set options for the video sequence. For more information, see

Setting Up for Video Capture.
4 Capture the video sequence. For more information, see Capturing Video.
5 Use the VidEdit application to edit the captured video sequence. You can use VidEdit to 

save the sequence in compressed format. For information about editing and compressing
video, see Help for VidEdit.

Capture Methods
VidCap provides two modes for capturing video sequences: 

Real-time capture
Step-frame capture

Real-time capture processes a video sequence and audio as the events occur naturally, or 
as the video source plays without interruption. Step-frame capture pauses the video source
as it collects each frame (image) of data, and, if audio is also selected, rewinds the media 
in the video source and collects audio data as the video source plays a second time.
Real-Time Capture
A video source for real-time capture (such as a video camera or videodisc) provides an 
uninterrupted stream of information to the capture hardware. The capture hardware copies 
each frame of the video sequence (and each portion of audio) and transfers it to disk 
before the next frame of data enters the capture hardware. A video frame contains one 
image of the video sequence. 
Real-time capture demands a fast computer and hard disk. The computer must process and
store the incoming video frame before the next frame is received in the capture board. If 
the system falls behind during capture, frames of video data are dropped (lost). 
Step-Frame Capture
Step-frame capture collects video frames from a video sequence in a series of steps. In 
step-frame capture, frames are captured one at a time, generally from a paused video 
device. You can perform step-frame capture manually, advancing the video source using 
the controls on the video device. VidCap also provides automatic step-frame capture for 
video devices that support the Media Control Interface (MCI). With this method, VidCap 
issues frame-advance commands to the source device and captures the sequence frame-
by-frame. When VidCap finishes capturing the current frame, it advances the video source 
to the next capture point. 
Step-frame capture provides an alternative for systems that cannot process a video 
sequence in real time. Because the system can fully process a video frame before 
contending with the next, you can use larger frame sizes and color formats, and you can 
optionally compress the video sequence during capture. When a step-frame capture is 
complete, you can capture the audio segment associated with the video frames by playing 
the source video a second time. 



See Also 
Setting Up for Video Capture
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Tips for Improving Video Quality

 In addition to mastering the basics of capturing, editing, and compressing video, you 
should know how to adjust the physical elements of the recording set to improve the 
recording quality your digital-video clips. The following sections provide tips for improving 
the quality of your videos. You should consider the following areas:

Lighting
Video-source quality
Audio-source quality
Recording distortion
Compression Considerations

Using Lighting Effectively
While many cameras can be adjusted for low-light conditions, a well-lit scene vastly 
improves video quality. Improved lighting makes colors richer; details appear clearer. Also, 
many computer monitors cannot display subtle differences in low-light scenes, especially 
when compared to TV or video monitors.
Although shadows play an important role in traditional film-lighting schemes, they can 
greatly increase the storage and data-transfer requirements for digital movies. Shadows 
increase the number of color variations from frame to frame, thus increasing the amount of
data needed to represent each frame. To reduce color variations (thereby improving 
playback performance), you can use a flat lighting scheme that illuminates the subject from
all sides, eliminating shadows.
Improving the Quality of the Video Source
Use high-quality video formats such as Hi-8, and always use a master or first-generation 
tape. Subsequent generations increase background noise, which not only affects playback 
quality, but results in lower compression ratios. Remove all sources of noise from your 
video by cleaning the playback head on your VCR, by connecting your computer, VCR, and 
camera to a common ground, and by using shielded cables.
Improving Audio Quality
Check the level of the your audio using the Level button in the Audio Format dialog box. You
should adjust the audio level so that the loudest audio passages are about 80% of the full 
range. Also, you should make all of your recordings at a consistent audio level.
Retaining Detail in the Video Sequence
All forms of digital recording are subject to distortion known as aliasing. In digital video, this
distortion appears as moire patterns, or other visual effects. Aliasing happens when the 
sampling rate is insufficient to capture all the data coming in from the analog-video source. 
Capturing video images at 320-by-240 or 160-by-120 resolution can result in the loss of fine
detail within the video image. For example, at 160-by-120 resolution, only every fourth line 
of an incoming video signal is retained. Thin lines in the image (for example, telephone 
poles) can be dropped entirely.
Some video-capture hardware uses low-pass filters to reduce aliasing as the size of the 
capture window is reduced. If your video-capture hardware does not include anti-aliasing 
filters, try the following:

Use the 2x Spatial averaging technique provided by VidCap. You can use this 
technique when capturing from video-source devices that support the Media Control 
Interface (MCI). For more information, see Controlling the Video Source During Automatic 
Capture.

When recording finely detailed objects, zoom-in as close as possible.



Avoid using materials in your video sequences that contain patterns; for example, 
venetian blinds, tiles, checker boards, and plaids.
Reducing Color Distortion
When capturing using the 8-bit video format, which uses a 256-color palette, you might 
experience flickering caused by color variations produced by the analog-to-digital 
conversion. These variations aren't as apparent in the 16- or 24-bit formats. To reduce 
flickering when capturing 8-bit sequences, you can use a VidCap averaging technique 
available when capturing frames from an MCI-supported source device. For more 
information, see Controlling the Video Source During Automatic Capture.
Compression Considerations
By recording clips that compress well, you can create smaller compressed files, as well as 
reduce the load on system resources during playback. Use the following guidelines to 
improve compression:

Minimize the amount of the image that changes between frames.
A static landscape clip produces great compression ratios. Panning or zooming the 
camera while recording decreases the compression ratio.

Use broad areas of constant color, which compress better than fine-grained detail. 
When using backdrops, select solid colors rather than textured areas. 



See Also 
Getting Started with Video for Windows



VidCap Toolbar and Controls

Click the controls in the following illustration for an explanation of the VidEdit control:



See Also 
Configuring VidCap
Adjusting the Look of VidCap



File Menu Commands

The File menu contains the following commands:
Command Description
Load Palette Imports an 8-bit color palette for use in the 

video sequence. You can load a palette from a 
bitmap (.DIB or .BMP) file or palette (.PAL) file. 
The palette you load replaces the default gray-
scale palette provided by VidCap.

Set Capture File Identifies and creates the file that stores 
captured video sequences.

Save Captured 
Video As

Copies the contents of the current capture file to
another file.

Save Palette Saves the palette of the current capture file as a
palette (.PAL) file.

Save Single Frame Saves the current frame as a bitmap (.DIB) file.
Edit Captured Video Starts VidEdit, the editing application, and loads 

the current video sequence.
Exit Exits VidCap.



See Also 
Saving Video Files
Preparing the Capture File
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Edit Menu Commands

The Edit menu contains the following commands:
Command Description
Copy Copies the current frame image, including the 

palette, to the Clipboard.
Paste Palette Pastes a palette from the Clipboard into VidCap. 

VidCap uses this palette when setting colors for 
a captured image or video sequence that uses 
the 8-bit color format.

Preferences Lets you customize VidCap display settings 
(these settings have no effect on the video 
sequence).



See Also 
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Options Menu Commands

The Options menu contains the following commands: 
Command Description
Audio Format Sets characteristics for the audio track of the 

video sequence.
Video Format Sets the dimensions and color format of 

captured images.
Video Source Sets the type of input signal supplied by the 

video source. 
Video Display Sets the source for the video monitor or, for 

capture hardware with overlay capability, sets 
the display characteristics of the video overlay.

Video Compression Sets software compression routines to use 
during the capture session (generally used only 
with frame-by-frame capture).

Preview Video Sets the VidCap display area to display an image
stored in the frame buffer.

Overlay Video Sets the VidCap display area to display the 
video-input signal.



See Also 
Setting Audio Options
Setting Video Options
Setting the Video Source
Setting Video Display Options
VidCap Toolbar and Controls



Capture Menu Commands

The Capture menu contains the following commands:
Command Description
Single Frame Captures the current frame from the video board

and displays it in the frame area.
Frames Manually captures video frames from the source 

to a capture file. You indicate each frame you 
want to capture as it appears in the display 
area. 

Video Automatically captures a sequence of frames, at
a specified frame rate, to a capture file. This 
command controls video capturing in real time. 
It also provides step-frame capturing and 
software control of the video source (if a 
software driver used to control the video source 
is available).

Palette Captures color information from the incoming 
video stream. Using this command, you can 
build a color palette from specific images in a 
video stream (by manually specifying the 
images) or from a series of frames captured 
automatically by VidCap.

See Also 
Setting Up for Video Capture
Capturing a Video Sequence Manually
Capturing a Video Sequence Automatically
Controlling the Video Source During Automatic Capture
Setting the Palette



Help Menu Commands

The Help menu contains the following commands:
Command Description
Contents Displays the Contents topic of this Help file.
About Displays the version number and copyright statement 

for VidCap.

See Also 
Press F1 for information on using Help.



Overview: Configuring VidCap

Each capture board has unique controls and options. VidCap can display customized video-
source settings for your capture board, so you can configure the application to take full 
advantage of the features of the capture board. You can also adjust the appearance of the 
VidCap window by selecting options in the VidCap Preferences dialog box. The following 
topics describe how to configure VidCap.



See Also 
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Adjusting the Look of VidCap

There are several ways to customize the appearance and contents of the VidCap window. 
These settings are available from the VidCap Preferences dialog box.

 To set editing preferences
1 From the Edit menu, choose Preferences.
2 Select the visual preferences you want. For information about the preferences, see 

VidCap Preferences Dialog Box.
3 Choose OK.



See Also 
VidCap Preferences Dialog Box
Setting the Video Source
Setting Video Display Options



Setting the Video Source

Some capture boards can process several types of video signals. Depending on the 
capabilities of the capture board, VidCap might provide any of the following options for 
specifying the video source:

Source format (for example, RGB, composite, or SVideo)

Video standards (NTSC, PAL, or SECAM)

Hue, saturation, and contrast levels
These options vary among different capture boards. You should consult the documentation 
for your capture board.

 To set the video-source type and component levels
1 From the Options menu, choose Video Source.
2 Select the appropriate video-source options. For more information about the options, see 

Video Source Dialog Box.
3 Choose OK.



See Also 
Video Source Dialog Box
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Setting Video Display Options

VidCap can display one of the following images in its window:

The incoming video signal (before capture)

A preview of the captured video frames (after capture)
To display the incoming video signal in the VidCap window, you need a capture board that 
supports video overlay. You can view the video-overlay signal to find the frames you want 
to include in the sequence. However, to view the captured frames, you must preview the 
captured video sequence.
If your capture board lacks overlay capability, you might be able to display the video signal 
or the captured frames on a secondary display monitor connected to the output port of the 
capture board.
Note During video capture, VidCap places highest priority on maintaining the flow of data 
from the capture board to the capture file. Because displaying captured frames requires 
some processing resources, VidCap might not be able to update the display area during 
capture. (This is not a problem when displaying the incoming video signal using an overlay 
board.) 
Video Display Options for Overlay Boards
When displaying the incoming video signal, you can adjust the colors, contrast, and 
saturation of the signal to improve the picture quality in the VidCap display area. These 
settings don't affect the quality or color of images captured; they just adjust the look of the 
display area.

 To display captured frames in the VidCap display area

From the Options menu, choose Preview Video.
Or, from the toolbar, choose the Preview Video button .

 To display the video-overlay signal in the VidCap display area

From the Options menu, choose Overlay Video.
Or, from the toolbar, choose the Overlay Video button .

 To adjust the picture quality of an overlay display
1 From the Options menu, choose Video Display.
2 Adjust the video-overlay signal characteristics as needed. For information about the 

options, see Video Display Dialog Box.
3 Choose OK.
Video Display Options for Non-Overlay Boards



With non-overlay boards, VidCap always displays the captured video frames in the display 
area. You might be able to connect a second monitor to the output port of the capture 
board and use this monitor to display either the incoming video signal or the captured 
video frames. 

 To select what to display on the output monitor
1 From the Options menu, choose Video Display.
2 Choose the appropriate signal source for the output monitor.

To display captured frames (the contents of the frame buffer on the capture card), select 
Frame Buffer Image. 
To display the incoming video signal (from which the capture hardware builds video 
frames), select Video Input Signal.

3 Choose OK.



See Also 
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Overview: Setting Up for Video Capture

Before capturing video, you must perform the following tasks:

Create a capture file
VidCap captures video and audio data to a capture file, which is created on your hard 
disk before the capture session starts. By pre-allocating a capture file, you assure 
sufficient space for storing incoming video and audio data.

Select option settings for the video sequence
Your video-capture system can handle various color settings, frame sizes, and audio 
formats. Some capture boards offer hardware-based assistance for compressing a video 
stream during capture. VidCap lets you take full advantage of all the performance 
capabilities of your capture hardware. You can adjust these settings for different video 
sequences, achieving the desired balance between quality, storage requirements, and 
data-transfer rates.

Create a capture palette (assuming you're using the 8-bit color format)
You'll want to create optimal palettes for video sequences being played on 8-bit (256-
color) systems. VidCap lets you create representative palettes by sampling colors 
appearing in one or more frames of the video source signal; you can apply these palettes
during the capture process, or you can save them and apply them later using the editing 
application, VidEdit. 

Test the setup
Once you've finished configuring your capture settings, you can test the setup by 
capturing a few test frames. Capturing and compressing video can be a time-consuming 
process, so it's a good idea to carefully adjust your settings up front, before you capture 
a lengthy sequence.

You won't have to perform all these tasks every time you capture video; most can be 
performed once, the first time you capture video. Later, you can adjust the settings as 
needed to achieve the desired playback performance. The following topics in this sequence 
discuss the various setup tasks.



See Also 
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Preparing the Capture File

Before capturing video sequences, you must identify a capture file. The capture file sets 
aside an area of your hard disk to receive captured video and audio data. By ensuring that 
the capture file exists in a contiguous area on your hard disk, you can allow the highest 
possible disk-write speeds and reduce the chances of losing data due to disk seeks.
When creating a capture file, specify a size large enough to hold the entire video sequence.
If you run out of room while capturing, VidCap will attempt to enlarge the file to hold the 
captured data. However, enlarging a capture file might cause the file to become 
fragmented and might also cause one or more frames to be dropped. 
Hint You can use a capture file multiple times; when you finish capturing video, just save 
the video sequence to a different filename. You can also set aside multiple capture files.

 To set the capture file
1 From the File menu, choose Set Capture File.

Or, choose the Set Capture File button .
2 Type a filename for the capture file.
3 To specify the size of a new capture file, or to change the size of an existing file, choose 

the New Size button, type a size in megabytes, and choose OK.
4 From the Set Capture File dialog box, choose OK.
Defragmenting the Capture File
After allocating a capture file, you should use a disk-defragmentation utility to defragment 
the hard disk on which the capture file is stored. If the capture file does not reside in 
contiguous sectors of your hard disk, your system will be forced to perform a disk seek 
during the capture session, which might result in dropped video or audio data. 
To defragment the hard disk, you can use a disk defragmentation application, such as the 
Defrag utility included with MS-DOS version 6.0.
Example of Capture-File Size
The following sample-video sequence would require approximately 23 megabytes of disk 
space:
Attribute Value
Length 1 minute
Compression None
Color format 8 bits per pixel (using a palette)
Frame size 160-by-120 pixels
Frame rate 15 frames per second
Audio format 8-bit samples, mono, 11.025 kHz sampling rate

See Also 
Set Capture File Dialog Box
Saving Video Files



Setting Audio Options

Audio options determine the quality and storage requirements of the audio for your video 
sequence. Higher-quality audio takes more storage space, so you'll have to decide on an 
appropriate mixture of settings. 
Audio formats range from the equivalent of a voice-grade telephone line (8-bit samples, 
mono channel, and 11.025 kHz frequency) to audio-CD quality (16-bit samples, stereo 
channels, and 44.100 kHz frequency). To capture audio with the video, you must have the 
audio sources connected to the audio-input ports on your audio card. 
Hint If you work with multiple input sources, use a mixing board to select among the 
sources.

 To set the audio-data track format and sample rate
1 From the Options menu, choose Audio Setup.
2 Select the appropriate audio options. For information about the settings, see Audio 

Format Dialog Box.
3 Choose OK.

 To set the maximum recording level of the audio input
1 From the Audio Format dialog box, choose the Level button.
2 While observing the volume bar, adjust the audio source so the volume peaks at about 

80% of the full range shown on the volume bar. 
3 Choose OK.



See Also 
Audio Format Dialog Box
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Setting Video Options

You can choose the frame size and color format for the video sequence. Larger frame sizes 
provide greater impact but require more storage space. Video sequences can use an 8-bit 
color format with palette; this format plays on the widest variety of video displays and 
requires the least storage space. You can also use 16- or 24-bit formats that preserve the 
original colors, but might also require three times the storage space.
The specific video-format options depend on the capabilities of the capture board. In 
addition to the frame-size and color-format options, some capture boards offer hardware-
based compression routines that you select while choosing video options.

 To set the video options
1 From the Options menu, choose Video Format.
2 Select the appropriate size and color-format options. For information about the options, 

see Video Format Dialog Box.
3 Choose OK.



See Also 
Video Format Dialog Box
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Setting Compression Options

You might be able to use software-based compression routines to compress the audio and 
video data during the actual capture session. When performing a step-frame capture (one 
frame at a time), your system has enough time to compress the current frame before 
processing the incoming data for the next frame. However, it's unlikely that your system 
will be able to perform software compression during a real-time capture, when the video 
source is playing at normal speed.
The specific compression routines provided by VidCap depend on the capabilities of the 
capture board and on the compressors installed on your system.
Note If your capture boards supports hardware-based compression schemes that can be 
used during capture, select those schemes from the Video Format dialog box. For 
information about selecting video-format options, see Setting Video Options.

 To set compression options
1 From the Options menu, choose Video Compression.
2 Select the compression options. For information about the options, see Video 

Compression Dialog Box.
3 Choose OK.



See Also 
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Setting the Palette

Two main color models are available for video sequences:

An 8-bit color model that's compatible with the majority of video adapters. With 8-bit 
color, all the colors for a video frame are stored in a palette, a table of color values. 
Individual pixels within the video frame reference the entries in the table. An 8-bit palette 
can contain a maximum of 256 color entries, so you're limited to 256 colors per video frame.
A video sequence can have multiple palettes, but switching from one palette to the next can
cause undesirable color effects during playback.

16- or 24-bit color models that preserve more of the original colors from the video 
signal but require at least two to three times more storage space. A 16- or 24-bit video 
sequence will show significant color changes when played back on common 8-bit video 
adapters. 
When capturing video using the 8-bit (palette) format, VidCap uses a single palette for all 
video frames. Some capture drivers provide a 64-shade gray-scale palette, but you can 
supply a custom color palette compatible with the colors used in the video signal. 
Applying an 8-Bit Palette to a Video Sequence
There are two ways to supply a palette for use in a video sequence:

Load a palette from a palette (.PAL) file. For example, you might create a standard 
palette for use in several video sequences; you can save this palette as a .PAL file and then 
use it whenever you capture video.

Use VidCap to create a palette from one or more frames of the video sequence. This 
approach lets you build a custom palette using the most-common colors in the video 
sequence. Once you create a palette from the video sequence, you can save it for later use 
with other sequences.
Be sure to experiment with different palettes before finalizing your video sequences. The 
right palette can dramatically improve the quality of your video sequence. 
Hint If your capture board supports the 16-bit or 24-bit formats, you can capture in these 
"true-color" formats. You can then load the "true-color" version into VidEdit and experiment 
with various 8-bit palettes.

 To build a palette from one or more frames
1 From the Capture menu, choose Palette.
2 Type the number of colors you want for the palette. You can type the following values:

Value Description
1 through 236 Builds a palette with the specified number of 

entries. Larger numbers of entries provide more 
color choices, while smaller values can result in 
substantial reductions in file sizes after 



compression.
256 Builds an identity palette, with 236 colors 

defined from the incoming video signal, and 20 
system-defined colors. Identity palettes provide 
more efficient processing during playback.

3 Choose from the following actions:
To Do This
Capture colors from a single 
frame

Choose the Frame button each 
time you want to capture colors 
from an image.

Start capturing colors from 
multiple frames

Choose the Start button to start 
capturing.

If the palette is for a video sequence, include several frames of data in the sequence 
from which you build your palette. By capturing colors from several frames, you provide 
a better representation of colors for the video sequence.

4 Choose the Close button.
There will be a slight delay while VidCap creates an optimal palette from the captured 
frames.

 To save a palette
1 From the File menu, choose Save Palette.
2 Select the filename for the palette (.PAL) file.
3 Choose OK.
Note If you haven't created a palette from the video sequence (as described in the 
preceding procedure), the video-capture driver will supply a default palette. This palette 
might be a color or grayscale palette, depending on the capabilities of the capture driver.

 To load a palette from an external file
1 From the File menu, choose Load Palette.
2 Select a palette (.PAL) file.
3 Choose OK.

There is a short delay while VidCap loads the new palette.



See Also 
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Testing the Setup

After configuring your video-capture settings, you can capture a single frame and display it 
in the VidCap display area. If your capture board has overlay capabilities, be sure to set the
VidCap frame display to show the capture preview rather than the overlay (from the 
Options menu, choose Preview Video).
If you're using the 8-bit (palette) color format, you should also determine whether your 
color palette is compatible with other images you plan to display in your presentation. 
Systems with 8-bit video adapters can display a maximum of 256 colors simultaneously. If 
two video sequences (or a video sequence and an image) use completely different colors, 
the system will be unable to display correct colors for both images simultaneously. 
To test your palettes, display the video sequences together simultaneously (you can run 
multiple copies of VidEdit and display one sequence in each). The video sequence in the 
active application will have priority for palette entries, so examine the inactive video 
sequence to see if any color changes occur. Whenever you display multiple images 
together on an 8-bit video display, it's a good idea to build composite palettes that contain 
the necessary color entries for all the images. Using composite palettes can prevent 
unexpected color changes during your presentation.



See Also 
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About the Capture Process

You can capture video sequences manually or automatically using VidCap. In either case, 
the captured video and audio data is stored in a pre-allocated capture file on your hard 
disk. Before starting video capture, you should create a capture file and set all the 
necessary options for the video sequence; for an overview of this process, see Setting Up 
for Video Capture.
You should consider the following techniques for capturing video:

Manual (step-frame) capture: With manual capture, you advance the source device 
frame-by-frame to display the necessary video images. Whenever a desired image is 
displayed, you capture the frame. This is a useful technique for capturing individual still 
images from a video source.

Automatic capture: With automatic capture, you capture a stream of video played at 
normal speed from the source device. During automatic capture, VidCap captures frames at 
the specified frame rate, storing the data in the capture file. Automatic capture can place 
high demands on your system because the hard disk needs to keep up with the incoming 
video and audio data. Be sure to use a fast computer with a fast hard disk, and prepare a 
defragmented capture file before beginning the capture process.

Automatic capture, with Vidcap controlling the source device: If your source device 
(videodisc player or videocassette recorder) includes a Media Control Interface (MCI) device 
for controlling playback, VidCap can issue commands to position and play the device during 
the capture session. On videodisc players, you can also perform a step-frame capture, in 
which frames are advanced and captured at low speed, allowing a larger frame size and 
color format.
These techniques are all discussed in the following topics in this sequence.
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Capturing a Video Sequence Manually

You can capture a video sequence manually, one frame at a time. Frames are captured to 
the file you specified (for information about specifying a capture file, see Preparing the 
Capture File). After capturing a series of frames, you can save the video sequence to a 
different filename.

 To capture frames manually
1 From the Capture menu, choose Capture Frames.
2 Start the video-source device.
3 Each time the first frame you want to capture is displayed on the output monitor, choose 

the Capture button on the Capture Frames dialog box.
4 When you finish capturing frames, choose the Close button, or press the ESC key.
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Capturing a Video Sequence Automatically

You can capture a series of frames automatically. In an automatic capture, you specify the 
attributes of the video sequence and then capture the sequence to the capture file (for 
information about specifying a capture file, see Preparing the Capture File). After capturing 
a series of frames, you can save the video sequence to a different filename. 
When capturing video, you can control your video source in the following ways:

Manually (using the controls on the camera, videodisc player, or videocassette 
recorder).

Automatically, using a Media Control Interface (MCI) driver. With MCI control, you can 
specify the starting and ending points for the playback, and VidCap plays the specified 
segment automatically when you start capturing. For more information about MCI control, 
see Controlling the Video Source During Automatic Capture.
With either method, you begin by specifying a series of attributes for the video sequence. 
You then start the capture. You can capture for a preset period of time (for example, 
capture 3 minutes of video), or you can stop capture by pressing the ESC key.
Note During capture, your hard disk might not keep up with the frame rate you specified. If
this occurs, VidCap inserts blank frames where it is unable to store frame data. When the 
capture session is complete, VidCap reports the number of blank or dropped frames. 
Dropped frames use minimal storage space (8 bytes) and do not adversely affect 
audio/video synchronization.

 To capture a series of frames automatically
1 From the Capture menu, choose Video.
2 Select the recording options you want for the capture session. 

For information about capture options, see Capture Video Sequence Dialog Box.
For information about the audio-recording format (available from the Audio button), see 
Audio Format Dialog Box.
For information about the video-recording format (available from the Video button), see 
Video Format Dialog Box.
For information about settings for controlling the video source using MCI, see MCI 
Settings Dialog Box.

3 If you're manually controlling your source device, start your source device.
4 To start capturing frames, choose OK.
5 To end capture, press the ESC key.

During the capture session, VidCap reports capture information in the status bar.



See Also 
Capture Video Sequence Dialog Box
Audio Format Dialog Box
Video Source Dialog Box
MCI Settings Dialog Box
Preparing the Capture File
Setting Audio Options
Setting Video Options
Controlling the Video Source During Automatic Capture
Saving Video Files



Controlling the Video Source During Automatic Capture

If your videodisc player or videocassette recorder has a Media Control Interface (MCI) driver
for controlling playback, you can have VidCap control the video-source device during the 
capture operation. MCI drivers are available for several videodisc players and for Sony 
Visca-compatible videotape recorders (such as the CVD-1000 VDeck). Contact the 
manufacturer of your videodisc or videocassette player to see whether there's an MCI 
driver available.
Using MCI control, you can specify the starting and ending points of the segment to 
capture. VidCap can automatically start playback at the desired position, capture the 
specified video segment, and then stop capturing at the end location. 
On videodisc players, you can also perform a step-frame capture, in which VidCap single-
steps the player from frame to frame, capturing each frame at low speed. Step-frame 
capture can allow larger frame sizes and video formats (such as 24-bit color) than might 
otherwise be possible using a real-time capture.

 To set an MCI-compatible video source for an automatic capture session
1 From the Capture menu, choose Video.
2 Select the appropriate options in the Capture Video Sequence dialog box.
3 Select MCI Control Of Source Video.

The MCI Settings dialog box appears.
4 Select the options you want.
5 Choose OK.
6 From the Capture Video Sequence dialog box, choose OK. VidCap positions the device 

and starts the capture session. 
Note If the MCI control of the source-video option is unavailable, you must install an MCI 
device driver for your video source. Use the Drivers application from the Control Panel to 
install the MCI device driver.



See Also 
Capture Video Sequence Dialog Box
MCI Settings Dialog Box



Saving Video Files

You can save the captured video data in the following formats:

You can save the capture file to a different .AVI filename. This lets you use the 
capture file to store a new video sequence.

You can save the currently captured frame as a bitmap (.DIB) file. You can also copy 
the bitmap to the Clipboard.

You can save the palette as a palette (.PAL) file. If you create a palette for a video 
sequence, VidCap will save that palette; otherwise, it saves a default palette provided by the
capture-board driver.

 To save captured video data
1 From the File menu, choose one of the following commands, depending on what type of 

file you want to save:
File Type Command
Video sequence (.AVI) 
file

Save As

Bitmap (.DIB) file Save Single Frame
Palette (.PAL) file Save Palette

2 Type the filename.
3 Choose OK.



See Also 
Capturing a Video Sequence Manually
Capturing a Video Sequence Automatically
Setting the Palette



Load Palette Dialog Box

Use this dialog box to load an 8-bit color palette from a palette (.PAL) file. The palette will 
be used for the entire video sequence. For information about using color palettes in a video
sequence, see Setting the Palette.
The dialog box has the following options:
Option Description
File Name Identifies the currently selected file. To specify 

another file, select another filename from the 
list beneath the box, or type another filename.

Directories Specifies the directory path that contains the 
current file. To specify another directory, select 
another directory from the list beneath the box, 
or type another directory path in the File Name 
box.

List Files Of Type Specifies the type of file that you want to use. To
specify another type of file, select another entry 
from the list beneath the box.

Drives Specifies the device that contains the current 
file. To specify another device, select another 
device from the list beneath the box, or type 
another device name in the File Name box.

OK Opens the specified palette file.
Cancel Closes the dialog box without opening a palette 

file.



See Also 
Setting the Palette



Set Capture File Dialog Box

Use this dialog box to specify a file to store the captured video and audio data. By creating 
the capture file before the capture session, you allocate space on your hard disk for the 
audio and video data, which comes in at high speed from the capture board. For more 
information about capture files, see Preparing the Capture File. 
The dialog box has the following options:
Option Description
File Name Identifies the currently selected file. To specify 

another file, select another filename from the 
list beneath the box, or type another filename.

Directories Specifies the directory path that contains the 
current file. To specify another directory, select 
another directory from the list beneath the box, 
or type another directory path in the File Name 
box.

List Files Of Type Specifies the type of file that you want to use. To
specify another type of file, select another entry 
from the list beneath the box.

Drives Specifies the device that contains the current 
file. To specify another device, select another 
device from the list beneath the box, or type 
another device name in the File Name box.

New Size button Displays the Set File Size dialog box for changing
the size of the capture file.

OK Sets the capture file to the specified filename.
Cancel Closes the dialog box without setting a capture 

file.



See Also 
Preparing the Capture File
Set File Size Dialog Box



Set File Size Dialog Box

Use this dialog box to change the size of a capture file. The dialog box shows the amount of
disk space available on the drive, as well as the current size of the capture file. To change 
the size of the capture file, type a new value (in megabytes) in the File Size box. Choose OK
to change the size; choose Cancel to keep the current size.



See Also 
Preparing the Capture File
Set Capture File Dialog Box



Save Captured Video As Dialog Box

Use this dialog box to save the video sequence to a different filename from the capture file.
The dialog box has the following options:
Option Description
File Name Identifies the currently selected file. To specify 

another file, select another filename from the 
list beneath the box, or type another filename.

Directories Specifies the directory path that contains the 
current file. To specify another directory, select 
another directory from the list beneath the box, 
or type another directory path in the File Name 
box.

List Files Of Type Specifies the type of file that you want to use. To
specify another type of file, select another entry 
from the list beneath the box.

Drives Specifies the device that contains the current 
file. To specify another device, select another 
device from the list beneath the box, or type 
another device name in the File Name box.

OK Saves the captured video sequence to the 
specified filename.

Cancel Closes the dialog box without saving the video 
sequence.



See Also 
Saving Video Files
Preparing the Capture File



Save Palette Dialog Box

VidCap can create an 8-bit palette using the colors in the video sequence, and you can 
save it in a palette (.PAL) file. The palette is provided by the capture-board driver and might
also be a fixed color or gray-scale palette.
The dialog box has the following options:
Option Description
File Name Identifies the currently selected file. To specify 

another file, select another filename from the 
list beneath the box, or type another filename.

Directories Specifies the directory path that contains the 
current file. To specify another directory, select 
another directory from the list beneath the box, 
or type another directory path in the File Name 
box.

List Files Of Type Specifies the type of file that you want to use. To
specify another type of file, select another entry 
from the list beneath the box.

Drives Specifies the device that contains the current 
file. To specify another device, select another 
device from the list beneath the box, or type 
another device name in the File Name box.

OK Saves the current palette to the specified .PAL 
file.

Cancel Closes the dialog box without saving the palette.



See Also 
Setting the Palette
Saving Video Files



Save Single Frame Dialog Box

Use this dialog box to save the current frame as a bitmap (.DIB) file. 
The dialog box has the following options:
Option Description
File Name Identifies the currently selected file. To specify 

another file, select another filename from the 
list beneath the box, or type another filename.

Directories Specifies the directory path that contains the 
current file. To specify another directory, select 
another directory from the list beneath the box, 
or type another directory path in the File Name 
box.

List Files Of Type Specifies the type of file that you want to use. To
specify another type of file, select another entry 
from the list beneath the box.

Drives Specifies the device that contains the current 
file. To specify another device, select another 
device from the list beneath the box, or type 
another device name in the File Name box.

OK Saves the current frame to the specified 
filename.

Cancel Closes the dialog box without saving the frame.



See Also 
Saving Video Files



VidCap Preferences Dialog Box

This dialog box lets you configure the appearance of VidCap. It has the following fields:
Option Description
Status Bar Specifies whether to display the status bar at 

the bottom of the VidCap window. 
Tool Bar Specifies whether to display the VidCap toolbar.
Center Image In 
Window

Specifies whether to display the frame image in 
the center of the window. If the option is cleared,
the frame is displayed in the upper-left corner.

Background Color Specifies which color to use for the background 
of the VidCap window.

Maximum Number 
Of Frames

Specifies one of two settings for the largest 
video sequence you plan to capture. To capture 
sequences longer than 32,000 frames, select the
324,000 setting.

OK Saves the preference settings.
Cancel Closes the dialog box without saving the 

preference settings.



See Also 
VidCap Toolbar and Controls
Configuring VidCap
Adjusting the Look of VidCap



Initialization Error Dialog Box

This dialog box is displayed when VidCap fails to initialize your video-capture hardware. The
message implies one or more of the following conditions:

The capture hardware is not installed.

The capture hardware has incorrect jumper or switch settings, or the settings conflict 
with settings of other installed devices.

The driver for the capture hardware is not installed.

Settings for capture driver conflict with settings of other devices, or do not match the
settings of your capture hardware.
Exit VidCap and verify the installation of the video-capture hardware and the capture driver.
For information about installing video capture hardware and related software, see the 
documentation for your capture board, as well as the Video for Windows User's Guide.
Hint To determine the interrupt settings and I/O ports used on your system, you can run 
the Microsoft Diagnostics (MSD.EXE) application. This application (run from the MS-DOS 
prompt) lets you view hardware settings on your PC. This information can be valuable when
configuring a video-capture board.



See Also 
Documentation for your capture board
Getting Started with Video for Windows



Audio Format Dialog Box

The Audio Format dialog box lets you select the following audio settings, which determine 
the quality and storage requirements for the audio track:
Option Description
Sample Size Defines the amount of storage used for each 

digitized portion of the waveform. 8-bit samples 
use less memory to store waveform information;
16-bit samples provide greater dynamic range.

Channels Specifies how many audio channels to use. 
Mono waveforms store audio information in a 
single audio track. Stereo waveforms use two 
tracks to store waveform information and double
the amount of audio information per frame.

Frequency Defines the rate at which audio samples are 
taken. The 11.025 kHz frequency (roughly 
equivalent to a voice-grade telephone line) 
samples over 11,000 samples per second. 
The 22.05 kHz frequency (equivalent in quality 
to AM radio) obtains samples twice as often as 
11.025 kHz frequency. 
The 44.1 kHz frequency is the sampling rate 
used for audio CDs.

Level button Displays a dialog box for setting the recording 
level.

OK Saves the audio settings.
Cancel Closes the Change Audio Format dialog box 

without saving the audio settings.



See Also 
Setting Audio Options
Set Record Level Dialog Box



Video Source Dialog Box

Use this dialog box to specify the signal type and format of the incoming video signal. 
Options for controlling video-source signals vary among capture boards, so the options 
displayed in this dialog box depend on your video capture board. For information about 
setting the video-source attributes, see the documentation for your capture board.



See Also 
Setting the Video Source



Video Format Dialog Box

Use this dialog box to select the video characteristics of the captured video sequence. 
These characteristics include the frame size and color format. Because the capabilities of 
capture boards vary, the contents of this dialog box depend vary among different capture 
boards. For information about the options, see the documentation for your capture board.



See Also 
Setting Video Options



Video Display Dialog Box (Overlay Control or Video Monitor)

Use this dialog box to select options for displaying the video sequence in the VidCap 
window, or on a secondary output monitor. VidCap displays one of two dialog boxes for 
setting video-display options: Overlay Control or Video Monitor.
The Overlay Control dialog box is used with capture boards that support video overlay and 
lets you adjust the appearance of the video-source signal when displayed in VidCap. The 
Video Monitor dialog box lets you choose which signal appears on the output monitor.
These options don't affect the video sequence; they just affect the display.



See Also 
Setting Video Display Options



Capture Frames Dialog Box

Use this dialog box to manually capture individual frames. This manual-capture method is 
useful for creating slide shows or individual image files captured from a video source.
Each time you choose the Capture button, VidCap saves the current video frame to the 
capture file. When you're finished capturing frames, choose the Cancel/Close button.
You cannot capture audio when capturing individual video frames.



See Also 
Capturing a Video Sequence Manually



Capture Video Sequence Dialog Box

This dialog box lets you specify parameters for the capture session and the video 
sequence, including the video and audio format. If your source device supports the Media 
Control Interface (MCI), you can also specify information for automatically playing the video
segment to capture. 
The dialog box has the following options:
Option Description
Frame Rate Sets the number of frames to capture per 

second. More frames per second provide better 
quality but require more storage space and 
faster data-transfer rates.
You can type the number of frames per second, 
as well as a fractional value; for example, 0.1 
specifies a frame every 10 seconds. The 
maximum is determined by the capabilities of 
your capture system, and the minimum is 1 
frame per minute (0.0166 frames per second).

Enable Capture 
Time Limit

Specifies whether to capture for a preset length 
of time. If this option is selected, you can type a 
time-limit value in the Seconds box.

Capture Audio Specifies whether to capture audio while 
capturing video, ensuring close synchronization 
between the audio and video tracks.

Capture Method Specifies one of the following methods for 
transferring data from the capture board to the 
capture file on the hard disk:

Directly to Disk  : This method requires a 
fast system. A small number of image buffers are 
allocated. 

Capture to Memory  : On slower computers,
the capture-to-memory option lets you capture 
short video sequences without dropping frames. 
However, this method does not work well for 
lengthy video sequences (regardless of the speed
of your computer). Most available memory is 
allocated for image buffers.

Video button Displays the Video Format dialog box for 
selecting frame size, color format, and other 
video attributes.

Audio button Displays the Audio Format dialog box for 
selecting the audio sample size, sampling rate, 
and channels (mono or stereo).

Compression button Displays the Video Compression dialog box for 
selecting compression routines to use during the
capture process.



MCI Control Of 
Source Video, MCI 
button

Specifies that VidCap will control the video 
source during the capture process. Selecting this
option automatically displays the MCI Settings 
dialog box.

MCI button Displays the MCI Settings dialog box for 
specifying MCI playback controls for the video 
source. This button is only available if MCI 
Control of Source Video is selected.

OK button Starts the capture session. Press the ESC key to 
end the capture session.

Cancel button Closes the dialog box without capturing video.



See Also 
Capturing a Video Sequence Automatically
Controlling the Video Source During Automatic Capture
Audio Format Dialog Box
Video Format Dialog Box
MCI Settings Dialog Box
MCI Step Capture Dialog Box



Capture Palette Dialog Box

This dialog box lets you create an 8-bit color palette using the colors of one or more video 
frames; you can then substitute it for the default capture palette. Use one of the following 
methods to capture the palette:

You can capture from a video source playing at normal speed. Specify when to start 
and stop capturing colors, and VidCap builds a composite palette using the colors captured 
from the video frames. 

You can capture one frame of colors at a time, capturing key scenes containing the 
desired colors for the sequence. 
With either method, capture several frames of video to obtain a representative sample of 
colors. Larger samples can provide a better selection of colors.
The dialog box has the following options:
Colors Description
Colors Specifies how many color entries to use in the 

palette. 
With values from 1 through 236, VidCap builds a 
palette with the specified number of entries. 
With fewer colors, you reduce the size of the 
sequence (after compression) because fewer 
changes occur from frame to frame.
With a value of 256, VidCap creates an identity 
palette that includes 236 colors captured from 
the video frames and 20 system colors reserved 
for use by Windows. An identity palette can 
provide better performance.

Frame button Captures colors from the current frame.
Start button Starts capturing colors automatically from the 

video source.
Close button Closes the dialog box. There will be a slight 

delay while VidCap computes the new palette.



See Also 
Setting the Palette



MCI Settings Dialog Box

If your source device supports the Media Control Interface (MCI), you can use this dialog 
box to specify which segment to play. When you start capturing, VidCap will position and 
play the specified sequence. Playback won't start until you start the capture process.
The dialog box has the following options:
Option Description
MCI Device Specifies the MCI device to play.

If your source-video device is not listed, you'll 
need to install an MCI driver for the device. Use 
the Drivers application in the Control Panel to 
install an MCI driver.

Source Capture 
Style

Specifies one of the following capture methods:

Play Video plays the video source at 
normal speed. VidCap captures the video 
sequence located between the Capture Start and 
Capture Stop positions.

Step Video plays the video source frame-
by-frame, allowing a larger frame size, higher 
frame rate, and optional compression. VidCap 
steps frame by frame, capturing single frames 
through the end of the video segment. After 
capturing the video frames, VidCap replays the 
selection at normal speed to capture audio.
Note CLV videodisc players do not allow 
stepping between frames, so VidCap will report 
an error if you use the Step Video method on a 
CLV videodisc player.

Step Frame 
Averaging

The following two options are used with the Step
Video capture method to bring out detail and 
reduce video noise:

2x Spatial specifies whether to expand the
frame size during capture to bring out more detail
in the image. VidCap doubles the frame size 
captured and then uses spatial averaging to 
reduce aliasing effects. This technique enhances 
fine lines in the sequence, at the cost of some 
fuzziness. 

n Frames Temporal specifies whether to 
reduce video noise by repeatedly capturing 
frames and averaging out the noise from the 
captured images. Specify how many images to 
capture and average per frame.



Note Some capture boards provide hardware 
routines for performing these enhancements. If 
your capture board includes such a feature, you 
should not select any of the step-frame 
averaging options provided by VidCap.

Capture Start Specifies the starting time for the capture in 
hh:mm:ss.ff format.

Capture Stop Specifies the ending time for the capture in 
hh:mm:ss.ff format.
If you specified a capture-time limit in the 
Capture Video Sequence dialog box, VidCap will 
stop capturing video at either the capture-time 
limit or at the Capture Stop time, whichever is 
smaller.

Set Start Sets the capture-start time to the current 
position of the MCI device. To position the 
device, you can use the controls on the player, 
or you can start the Media Player application 
and use the track bar to position the device.

Set Stop Sets the capture-stop time to the current 
position of the MCI device.

OK Saves the MCI settings. These settings are used 
when the capture session starts.

Cancel Closes the dialog box without saving the MCI 
settings.

See Also 
Capturing a Video Sequence Automatically
Controlling the Video Source During Automatic Capture



MCI Step Capture Dialog Box

This dialog box displays status information during a frame-by-frame step capture. The 
dialog box includes the following buttons:
Button Description
Stop Stops the video capture. If audio capture was 

also specified, VidCap then rewinds the source 
device and replays it to capture the audio track.

Cancel Stops the video capture without rewinding to 
capture the audio track.



See Also 
Capturing a Video Sequence Automatically
Controlling the Video Source During Automatic Capture



Set Record Level Dialog Box

This dialog box lets you monitor the recording level of your audio source. Observe the 
strength of the incoming signal, and adjust the volume on your source device so the 
volume peaks at approximately 80% of the audio range. To close the dialog box, choose OK.



See Also 
Setting Audio Options



Video Compression Dialog Box

This dialog box lets you specify software compression techniques to apply during a capture 
session. Because software compression requires processing time, it's generally 
inappropriate to use during a real-time capture, except at very slow frame rates. You can, 
however, use software compression during a step-frame capture.
Note The RLE compression method, which requires similar processing time during capture 
and playback, is the only one usable during real-time capture.
Some capture boards provide hardware-based compression that can be used during 
capture; however, these compression schemes are specified in the Video Format dialog 
box, not in this dialog box.
The contents of this dialog box are dependent on the video formats supplied by your 
capture board.



See Also 
Setting Video Options
Video Format Dialog Box





interleave
A method of storing video and audio data together in a
video file, such that a segment of video data is 
followed by a segment of audio data. By interleaving 
video and audio data, Video for Windows can maintain 
a smooth transfer of audio/video information while 
playing a video sequence from a hard disk or CD-ROM 
drive.

track
A linear depository of information within a video 
sequence. All video sequences have at least two 
tracks: a video track storing frames of video data, and 
an audio track storing segments of audio.

frame
A single unit of information within a video sequence. A 
video sequence consists of many frames of video and 
audio data; when the frames are played in sequence, 
you see an unbroken video sequence with 
accompanying audio playback.

palette
A collection of color information for a picture or video 
sequence. Video for Windows can use an 8-bit color 
palette, which provides up to 256 different colors for a 
video frame.

Video for Windows can use an 8-bit palette format. 
With this format, up to 256 color values can beare 
stored in a table. Images within the video sequence 
reference the entries in this table; each pixel has an 8-
bit value identifying which palette color to draw. The 8-
bit palette format uses less storage space than the 16-
bit and 24-bit formats, which do not use a palette 
(rather than reference a value in a table, they store 
color information directly with the pixel).

bitmap
An image format commonly used for scanned 
photographs and artwork. A bitmap divides a picture 
into a grid of pixels, with each pixel assigned a specific
color. Bitmaps usually have .BMP or .DIB extensions.

waveform audio
A technique of re-creating an audio waveform from 
digital samples of the waveform. The sound track for a 
video sequence is stored as waveform audio data.



insert mode
One of two VidEdit editing modes. In insert mode, 
space is provided for data added to the video 
sequence; existing data is retained and pushed later in
the sequence. When data is removed from a video 
sequence, data following the deletion is shifted back to
cover the empty area.

overwrite mode
One of two VidEdit editing modes. In overwrite mode, 
data added to the video sequence replaces any 
existing data at the insertioninseration point. When 
data is removed from a video sequence, the frames 
storing the deleted data are retained (so an empty 
frame results).

frame rate
The number of frames recorded for each second of 
video playback. Higher frame rates can provide 
smoother motion than lower frame rates.

dithering
A technique for simulating an unavailable color by 
combining two or more available colors.

sampling frequency
The rate at which digital- audio samples are taken. 
Higher sampling frequencies provide better fidelity but 
require more storage space.

sample size
The amount of storage space used for each digitized 
portion of the audio track. Larger sample sizes provide 
greater dynamic range and, therefore, better audio 
reproduction (, but they require more storage space).

stereo (audio)
Audio format in which two channels are used. Stereo 
audio can provide better sound reproduction but it 
requires twice the storage space as monaural (mono) 
audio.

mono (monaural audio)
Audio format in which a single channel is used. 
Monaural audio requires half the storage space as 
stereo audio, which uses two channels of audio 



information.

codec, or Compressor/Decompressor
A software component that provides compression 
services (while creating a video sequence) and 
decompression services (while playing a video 
sequence). The Video for Windows architecture 
provides for the use of multiple codecs, so you can 
choose the one that's most appropriate for your 
application.

data-transfer rate
The speed at which data is transferred from a storage 
device to the processing hardware of the computer. 
Devices with higher data-transfer rates can provide 
better playback quality.

key frame
A fully-drawn frame stored as a reference point for 
successive frames. Most video sequences store only 
the changes from frame to frame (they don't store a 
complete image for each frame). A key frame stores a 
complete frame image, so an application can jump to 
the key frame and obtain a fully-drawn image for that 
point in the video sequence.

direct-to-disk capture
VidCap transfers video data from the capture board 
directly to the MS DOS file system, using MS-DOS 
memory buffers for intermediate storage. If the hard 
disk falls behind during capture, VidCap automatically 
switches to the Capture Tto Memory option.

capture to memory
Rather than transfer data directly to disk, VidCap 
allocates memory using Windows (high memory) and 
copies video and audio data into these memory 
buffers. When these memory buffers are filled, 
however, the number of dropped frames quickly 
increases.

video sequence
A digital- video file created using Video for Windows. 
Video sequences consist of a series of frames of audio 
and video data. When played in sequence, the images 
and sound produce an animated video on the 
computer screen. Video sequences have a filename 
extension .AVI, for Audio-Video Interleaved.



audio and video source
The data stream captured as a digital- video sequence.
Video sources include videotape and videodisc players,
video cameras, and television tuners. Audio can also 
be captured from these devices.

capture board
A piece of computer hardware that receives video 
signals and stores incoming video images in a memory
area that can be accessed by system and application 
software.

audio board
A piece of computer hardware that plays and receives 
audio signals. Audio boards have circuitry that convert 
analog signals into digital format (for recording), and 
convert digital signals into analog format (for 
playback).

capture file
A file created on the hard disk for the purpose of 
storing captured video and audio data. Thise file 
provides storage space for the capture session, 
allowing the capture to proceed without taking time to 
allocate additional disk space for video and audio data.

Media Control Interface (MCI)
A standard control interface for multimedia devices 
and files. MCI lets a multimedia application control a 
variety of multimedia devices and files. VidCap uses 
MCI to play video previews and to control source 
devices such aslike laserdisc players and videocassette
recorders.

pixels
A single dot, or unit, within the computer display. The 
display is made up of a grid of pixels, each of which 
has its own color value.

compression
Compression reduces the storage requirements of a 
video sequence. Compression reduces the file size of 
the video sequence and also reduces the amount of 
data that mustneeds to be transferred to play a video 
frames. BecauseSince some storage devices 
(particularlyparticulary CD-ROM drives) have a 
relatively low data-transfer rate, reducing the amount 
of data that must beo transferred helps avoid skips 



and slowdowns during playback.

real-time capture
With real-time capture, you capture video data from a 
source device playing at normal speed. For real-time 
capture, you need a computer system fast enough to 
keep up with the data coming in from the source 
device. Data must be captured and stored on the hard 
disk before the next frame of information is received.

step-frame capture
With step-frame capture, you capture video one frame 
at a time, generally from a paused source device. You 
capture a frame, advance the source device to the 
next frame, and then capture the next frame. Step-
frame capture provides an alternative if your computer
systemmachine cannot capture in real time without 
losing data. Step-frame capture also lets you increase 
the frame size, use a larger color format, or perform 
software compression (because, since the system has 
more time to store the captured data).

video overlay
The capability of watching a video source in a window 
on the computer. The video signal from the VCR, 
camcorder, or other source device is synchronized with
the computer display and displayed within a window.

frame buffer
The memory area on the capture board used to store 
video data captured from the video source signal.

8-bit color format
A color format in which colors are stored in a separate 
table called a palette. The pixels within the video 
frame reference the entries in the palette (rather than 
store color information themselves). The palette format
provides a maximum of 256 unique colors within a 
video frame. Each color entry in the palette can use 
any of 16 million colors. Most multimedia computers 
can display 8-bit images; fewer support the 16- and 
24-bit formats.

The term ""8-bit"" refers to the amount of information 
encoded with each pixel. Each pixel contains an 8-bit 
number that references one of the entries in the color 
table.

contiguous



Residing within a single unbroken area of the disk. 
Hard disks are organized into sectors of data. A file 
might be stored across many sectors, and those 
sectors can reside in different areas of the hard disk. 
BecauseSince seeking to a different sector can take 
time away from the capture session, resulting in data 
loss, it's important to defragment the hard disk before 
capturing. This ensures the capture file resides in a 
contiguous area of the hard disk.

fragmented
Residing on non-contiguous sectors of the hard disk. 
When a fragmented file is written or read, the 
computer must skip to different areas of the hard disk 
to access the sectors making up the file. Seeking to a 
different sector takes time and can result in the loss of 
incoming video data.

defragmentation
Defragmentation utilities rearrange files so they reside 
in contiguous sectors of the hard disk. The DEFRAG 
command included with MS-DOS version 6.0 is one 
such utility.

16- and 24-bit color formats
Video for Windows color formats that store color 
information directly with the pixel (rather than in a 
separate color table, as is used with the 8-bit format). 
This means there is no limit to the number of unique 
colors within a video frame.

The 16- and 24-bit formats are called true-color 
formats because they preserve more of the original 
colors of the video signal. The 16-bit format provides a 
range of 32,767 color choices per pixel;, while the 24-
bit format provides a range of 16 million color choices 
per pixel.

identity palette
A palette containing the standard system colors 
arranged in a specific location (the top ten and bottom 
ten cells of the color table). An identity palette can be 
processed more quickly by Windows and can therefore 
provide improved display performance over a standard
palette.

dropped frames
Data lost during video capture. When capturing video, 
the system might notay be unable to finish processing 



the current video frame before receiving the next video
frame from the source device. The incoming frame is 
ignored, or dropped, and a blank frame is stored in its 
place.



Menu Bar
Contains a list of menus. You open menus and then 
choose commands from them to instruct VidCap to 
perform actions.

Set Capture File button
Names and creates the capture file (same as the Set 
Capture File command on the File menu).

Edit Captured Video button
Runs VidEdit and loads the captured video sequence 
into VidEdit for editing (same as the Edit Captured File 
command on the File menu).

Preview Video button
Displays the captured frames in the VidCap display area
(same as the Preview Video command on the Options 
menu).

Overlay Video button
Displays the video signal in the VidCap display area 
(same as the Overlay Video command on the Options 
menu).

Capture Single Frame button
Captures the current frame from the video board and 
displays it in the frame area (same as the Single Frame 
command on the Capture menu).

Capture Frames button
Manually captures a sequence of frames (same as the 
Frames command on the Capture menu). 

Capture Video Sequence button
Automatically captures a sequence of frames in real-
time or step-time (same as the Video command on the 
Capture menu).

Capture Palette button
Builds a palette from one or more frames of the video 
source (same as the Palette command on the Capture 
menu).

Video Frame Display
Displays either the captured video frame (the contents 



of the frame buffer on the capture board), or the 
incoming video signal (available only on overlay 
boards).

Status Bar
Displays status information for the capture session.




